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RAGE Sitemap Automator
XML Sitemaps are a way of telling search engines about your website. They 
provide unique information for each one of your web pages directing search 
engines on where to go, how often to go there, and when to come back to find 
fresh, new content.

With RAGE Sitemap Automator you can automate the process of creating XML 
Sitemaps by utilizing powerful filters and preset conditions so you don't have to 
go through thousands of pages yourself. Just enter your website address and 
RAGE Sitemap Automator will take care of the rest, generating Google, Yahoo, 
Ask and MSN compliant Sitemaps allowing you to take control of how search 
engines treat your web pages.

Help the search engines with their job so they can attract more visitors to your 
website!

About RAGE Sitemap Automator
Benefits of Having an XML Sitemap
Have you ever wondered why some of your pages show up in search engines, 
while others, containing much more important information, do not?

How do you get search engines to crawl your more important pages and add 
them to their search index?

The simple answer is, you have to take charge! Previously, search engines 
would just guess, or assume, some pages are more important than others. They 
would blindly crawl your pages not knowing if a page actually has been 
modified since their last visit or not, sucking up your bandwidth for no good 
reason.

With RAGE Sitemap Automator you now have the ability to take charge and lead 
search engines through your website. 

RAGE Sitemap Automator creates specially formatted sitemap files that search 
engines are able to read and extract important information about your website. 
With RAGE Sitemap Automator you don’t have to worry about the proper 
format or submitting your sitemap to search engines. Everything is taken care 
of for you.
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How RAGE Sitemap Automator Helps
RAGE Sitemap Automator takes the hassle out of collecting every single link 
from your website and creating a properly formatted XML Sitemap on your own. 
In addition, you can specify powerful filters that let you assign web page meta 
data, or extra info about your pages, automatically instead of manually going 
through hundreds of pages one by one.
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Installation
Drag the RAGE Sitemap Automator folder from the disk image to your 
Applications folder. Then, drag the disk image to your trash icon to unmount it.

Purchasing
RAGE Sitemap Automator is a shareware application and costs $29.95 USD. You 
may purchase RAGE Sitemap Automator safely and securely either within the 
actual software or by visiting http://www.ragesw.com/onlinestore.php. 

Purchasing either way is extremely safe and secure. Your registration 
information is sent immediately after your purchase so you won’t have to wait 
any more time to use the software. You may purchase through our secure 
online store, by Phone or by Fax. RAGE Software offers a variety of payment 
methods including credit card and PayPal. Visit our secure online store at 
http://www.ragesw.com/onlinestore.php for full details.

To purchase within the application, go to the Application Menu in the upper left 
hand corner of your screen where it says ‘RAGE Sitemap Automator’. Then 
select ‘Purchase RAGE Sitemap Automator’.

The integrated purchasing wizard will walk you step by step through the 
purchasing process, which will only take a few moments. Once your payment is 
processed your license will be automatically registered and you can begin to 
use RAGE Sitemap Automator at its full extent without any limitations.

Registration Benefits
When you register your copy of RAGE Sitemap Automator using the instructions 
above, you get the following additional features;

1) Automatically submit your sitemap to search engines
2) Create an unlimited number of XML Sitemaps
3) Remove the 25 link limit in your sitemap file
4) Lifetime use of the current version & minor updates without restrictions
5) Priority technical support
6) Removal of all nag screens
7) Free minor updates 
8) Discounts on major upgrades

Visit http://www.ragesw.com/onlinestore.php to register your copy.
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Where to Get Support
Please feel free to email Rage Software with any questions, comments or 
suggestions by visiting http://www.ragesw.com/support/ for a prompt reply. 
You may also use our free online discussion forums located at http://
www.ragesw.com/forums/ to talk about RAGE Sitemap Automator, Search 
Engine Optimization techniques, or any other topic related to web 
development.

You can search the RAGE knowledge base at http://www.ragesw.com/support/ 
to find answers to common questions as well as trouble shooting information.
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Getting Started
Generating an XML Sitemap for Your Website
RAGE Sitemap Automator is very easy to use. To begin, use the ‘New Sitemap 
‘toolbar button to add a URL to the WEBSITES list. You can add as many 
websites as needed.

Then simply select the website from the WEBSITES to create a sitemap for it.

Figure 1

Once you have selected your URL press the ‘Enter Filters’ button to create 
Filters that automatically apply certain meta data details to each URL or press 
the ‘Create Sitemap’ button to generate an XML Sitemap file.

Adding Filters
The real power of RAGE Sitemap Automator is its ability to automatically set 
your web page details for you, instead of you having to go through every single 
page one by one.

The way XML Sitemaps work is the Webmaster would essentially create a list of 
all URLs on their website along with additional information including;

1) How important each page is relative to every other page (Page Priority)
2) The date the page was last modified
3) How often the web page will change or be updated (Change Frequency)

Imagine if you had a website with just 100 links. You would have to go through 
each link, appending the above information to each page on your website. Now 
imagine you had 1000 links, or even 10,000 links. This results in very tedious 
work, which RAGE Sitemap Automator takes care of for you.
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Using the filters as shown in Figure 2, you can specify the priority, the last 
modified date, and the change frequency for specific pages which meet your 
specified criteria. For example, if you have hundreds of articles on your 
website stored in an ‘articles’ directory, you can specify every page contained 
in your ‘articles’ directory to have a priority of 1.0 (meaning very important 
relative to the rest of your website), and having a change frequency of never 
(since they are archived articles which won’t be changing). 

Figure 2

Filters can be set based on the entire URL, the parent directory of the current 
page, or the page file name. Filters can determine which pages to not check, 
what priority to set individual pages too, the change frequency of individual 
pages, and the last modified date of individual pages.

You can also create Filter groups if you plan on using the same filters many 
times over. Once you have added all of your filters select ‘Save As…’ from the 
Presets drop down menu. Give your Filter group a name and from now on you 
can simply select this Filter group preset whenever you want these filters to 
apply to a specific website.

Once you’ve added all of your filters, click the ‘Scan Website’ button so RAGE 
Sitemap Automator can gather all pages on your site.
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Scanning Your Website
Now that you’ve specified your URL and added all of your filters, its time to put 
RAGE Sitemap Automator to work.

RAGE Sitemap Automator will scan all pages on your website (except for those 
that you have specified not to in your filters) and add them to your sitemap. As 
it collects your web pages it will apply the filters you have set.

RAGE Sitemap Automator is compatible with cookies so it won’t index any 
incompatible session ID tags. If you’re unsure what those are, don’t worry 
because RAGE Sitemap Automator will take care of everything for you. 

Figure 3

In addition, RAGE Sitemap Automator will automatically get the last modified 
date of all of your pages, if available, so you don’t have to find this out 
yourself. If the last modified date is unavailable you can specify the default 
last modified date in the Preferences that should be applied to these files or 
set up filters to set the last modified date automatically for pages that meet a 
certain criteria.

You can cancel the website scan at anytime by clicking the ‘Stop’ button. Once 
the scanning is complete you will be sent to the Links Editor to confirm your 
sitemap and make any changes you see fit.
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Edit The Pages in Your Sitemap
After your website has been scanned you can add additional links, edit the 
displayed links or add meta information to your links.

You can easily set the priority and change frequency for each link listed from a 
drop down menu. If you would like to change the date modified or the actual 
link, double click the link you would like to change to reveal the Link Editor 
window.

Figure 4

You can add or remove additional URLs by clicking the 'plus (+)' or 'remove (-)' 
buttons in the lower right hand corner. If you would like to edit multiple link 
details at once, select the links you would like to edit and press the ‘edit’ 
button in the lower left hand corner next to the +/- button. 

If you need help finding a specific link you can use the ‘Filter Results’ search 
field located in the toolbar to quickly search the list of found pages. Once you 
have found a specific page you can easily edit the page details by following the 
same steps as described above.

You also have the option of rescanning your website, editing your filters and 
viewing the rejected URLs.
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If you would like to rescan your website, RAGE Sitemap Automator will ask if 
you want it to remember the meta details you have set. The meta details 
refers to the last modified date, change frequency and priority settings. Click 
Yes if you would like these details to be applied exactly as you have set them 
for each page once your rescan has been complete.

You can also edit your existing filters if you forgot to add one before scanning 
or you want to make a change to an existing one.

Lastly, you can view any URLs that were rejected by RAGE Sitemap Automator. 
These are URLs that could not be added to your XML Sitemap for various 
reasons such as a broken link, an unreachable URL, or a URL excluded because 
of a filter. The Rejected URLs window will let you know why any of your links 
could not be added so you can go back and fix the issue if necessary.

Once you’re satisfied with the results click the ‘Generate Site Map’ button to 
generate and upload your XML Sitemap file to your web server.

RAGE Sitemap Automator User Manual & Quick Start 11 of 25

Need help with creating your XML Sitemap? Want more Search Engine 
Optimization Techniques? Visit http://www.ragesw.com/forums/ to post your 
questions or comments on the free Web Development Discussion forums.

http://www.ragesw.com/forums/
http://www.ragesw.com/forums/


Publish Your Sitemap
Now that your XML Sitemap is complete, you can have RAGE Sitemap Automator 
publish it to the correct location on your website for you. Search engines 
require that your sitemap be in specific folders depending on the domain path 
that you have entered when you first scanned your website. RAGE Sitemap 
Automator makes sure your sitemap is published in the correct location.

RAGE Sitemap Automator can publish your sitemap to either an FTP server or an 
iDisk simply by selecting the appropriate option from the drop down menu. The 
following sections describe in detail how to publish your XML sitemap and 
submit it to search engines.
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Publish To Your FTP Server
Select ‘Publish To FTP’ from the drop down menu and click the ‘Publish’ button 
to enter your FTP information. Enter your server address, login name, and 
password. Then enter the default directory where all of your html and other 
website files are stored. If you do not know this information, email your web-
hosting provider and they will be able to provide you with all the details. Some 
common locations are included in the drop down menu on the right hand side.

Once you have entered all of your details, click the ‘Upload’ button. RAGE 
Sitemap Automator will upload your sitemap for you in the correct location.

Note: If you experience problems with the FTP uploading, you 
can upload using your favorite FTP client. Just press the 
‘Show in Finder’ button to get your sitemap. Than take the 
path shown in the Upload FTP window where it says ‘Your 
Sitemap Will Be Uploaded To:’ and upload your sitemap to 
that directory on your web server.
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Publishing To Your iDisk

RAGE Sitemap Automator can automatically publish your XML sitemap to your 
iDisk for you. Just select ‘Publish to iDisk’ from the drop down menu when on 
the ‘Publish Sitemap’ tab. Then click the ‘Publish’ button. The following dialog 
appears allowing you to enter your iDisk membername and your website name. 
If you scanned your http://web.mac.com address then these fields will be 
auto-filled for you.

Your Site name is the name that iWeb has given to your website directory. You 
can get your site name by opening iWeb and looking at the very top of the 
webpage file list on the left hand side. The directory containing all of your 
website files is your Site name. By default it will be Site, unless you have 
manually changed it or you have created more than one website.

Just press the ‘Publish’ button and RAGE Sitemap Automator will put your 
sitemap file in the correct location on your iDisk. It may take a few moments as 
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it loads and copies your XML Sitemap file onto your iDisk, so please wait a few 
moments while it gets copied. You will get a confirmation when the publishing 
has completed.

Testing your Sitemap
Once your sitemap is uploaded, you can press the ‘Test Sitemap’ button to 
make sure your sitemap is functional. RAGE Sitemap Automator will send a 
request to your server to ensure that the sitemap is in the correct location and 
can be properly accessed.

Submitting Your Sitemaps To Search Engines
Once you know your sitemap is functional, press the ‘Notify Search Engines’ 
button. If this is the first time you have uploaded the sitemap you must create 
a Google Webmaster Tools account online. Once your account is set up, RAGE 
Sitemap Automator will be able to notify Google and other search engines of 
your Sitemap changes for you automatically. 

When you want to update your sitemap, all you have to do is go to the File 
menu and select ‘Open’. Navigate to your Documents Folder/Google Sitemap 
Automator Maps/ to see all the sitemap project files you have created.

Open the project file and you can either add additional URLs manually or re-
scan your entire website. All of your filters are saved within your project file 
and pressing the ‘Notify Search Engines’ button will automatically tell the 
search engines about your sitemap update without you having to go online.

Creating Your Google Webmaster Tools Account
Google requires that you create a free Webmaster tools account in order to 
submit your XML sitemap to them. You only have to do this once and in the 
future when you update your XML sitemap, RAGE Sitemap Automator will 
automatically notify Google and other search engines about your changes.

In order to create a Google Webmaster Tools account go to https://
www.google.com/webmasters/tools. Once you have created your account and 
logged in, you will see the following screen.

1) Enter your website address and press the ‘Add Site’ button
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2) Click the ‘Sitemaps’ tab in the left hand navigation menu and then select 
‘Add Sitemap’. In the screen that appears select ‘Add General Web Sitemap’ 
from the drop down menu as shown.

3) Just enter ‘sitemap.xml’ without the quotes in the following field that 
appears. Then click ‘Add General Web Sitemap’. You may have to wait up to a 
few hours for your site to be accepted by Google, but it usually takes about 10 
minutes.
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4) Lastly you must verify your website with Google so that they can confirm 
that it is actually your website and they can use the information in your XML 
sitemap file. By verifying your website, you also get access to all the important 
information about your website.
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Click the Overview tab and then click the Verify website link. The easiest way 
to verify your website is to choose ‘Upload an HTML file’ from the drop down 
menu. Google will provide you with a special file name that you must publish to 
your website. If you use an FTP server, just create that file in your website’s 
root folder where all of your HTML pages are placed. 

RAGE Sitemap Automator can auto-
publish the verification file for you 
to either your FTP server or your 
iDisk. Just go to the File menu and 
Select ’Publish Verification File...’. 
RAGE Sitemap Automator will allow 
you to enter the name of the 
verification fi le and it will 
automatically put it in the correct 
location on your iDisk. Once you 
have completed this step, click the 
Verify link in your Google account.

After you have done this you are 
now finished and will not have to 
follow these steps again.

The next section describes how easy it is to re-submit your XML sitemap file 
once it has already been added to your Google Webmaster Tools account.

Updating Your Sitemap File
Once you have submitted your XML sitemap file once to your Google Webmaster 
Tools account, you no longer have to repeat these steps. Just remember to re-
open your website’s Profile from your Documents/Google Sitemap Automator 
Maps folder. This Profile file remembers that you have already submitted your 
XML sitemap to Google and won’t require that you do it again. 

Next time you press the ‘Notify Search Engines’ button, RAGE Sitemap 
Automator will notify all major search engines about your XML Sitemaps 
changes.

Submitting Your Sitemap To Yahoo, MSN/Live and Ask.com
Although Google invented the XML sitemaps protocol, most major search 
engines will utilize your XML Sitemap file. RAGE Sitemap Automator will notify 
these search engines as well when you press the ‘Notify Search Engines’ 
button.
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Like Google, if you create a special sitemaps account with Yahoo and MSN/Live, 
you can get some really interesting information about your website including 
what these search engines know about your site. Creating an account with 
these search engines is just as easy as creating your Google Webmaster Tools 
account.  Just follow these links to create your Yahoo and MSN/Live XML 
Sitemaps account. Ask.com does not yet provide the option of creating an 
account, but RAGE Sitemap Automator will still notify them of your XML 
Sitemap file.

Yahoo! Search: http://siteexplorer.search.yahoo.com/
MSN/Live Search: http://webmaster.live.com/

You will have to verify your website just as you did with your Google 
Webmaster Tools account. You can publish your verification file to your website 
using RAGE Sitemap Automator by going to the File menu and selecting ‘Publish 
Verification File’.
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Preferences
General Settings
These settings are the default meta information for the URLs that RAGE 
Sitemap Automator collects. If you haven’t set a filter for a specific  URL, these 
settings will be applied.

Default Priority
The priority settings specify how important the page is relative to all other 
pages on your site. The default, if left blank, is assumed to be 0.5 by search 
engines. Setting all pages to 1.0 will not increase your search engine results 
since the value is relative to other pages on your site. Setting them all to 1.0 
will simply devalue the importance of all pages.

Default Change Frequency
The default change frequency is how often a page is changed. It is just an 
estimate so don’t be to worried about being precise, search engines only 
provides the listed settings as possible options.

If a page is changed every single time it is accessed, for example, a page with 
live stock updates, you would specify ‘always’. If a page is never updated, for 
example an article archive, you can set the Change Frequency to ‘never’. Being 
honest with this setting can help save expensive bandwidth by reducing the 
amount of time the search engine crawlers visit unimportant pages on your 
website.

The default date modified option sets the last modified date of all pages that 
do not have this information set already. RAGE Sitemap Automator first 
attempts to get the real modified date and if it can’t, it will apply this setting.

Link Spidering
Link Spidering refers to how RAGE Sitemap Automator scans your website and 
collects links. From here you can modify its behavior.

Max Connections
Set the Maximum number of connections to use when scanning your website for 
links. Specifying a higher number of connections will be faster but requires 
much more CPU time. Set a lower number if you want to gather links in the 
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background. Also, a higher number may add more strain to your website and 
may be too much for your resources to handle. 

Timeout After
Specify the number of seconds you would like each connection to wait for a 
successful response. If no connection can be established after the above 
seconds the web page will be considered inaccessible and not added to your 
sitemap.

Connection Delay
Specify the delay between connections. A shorter delay will result in a faster 
scan but may use up more resources on your website. Lengthen the delay to 
ease the burden on your site.

Scanning Files
By setting filters you are able to completely ignore certain files. In contrast, 
the ‘Scanning Files’ tab allows you to prevent certain files from being 
downloaded and scanned for links. They will still be added to your sitemap file, 
they will just not be scanned for additional links.
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For example, you would most likely want all of your html pages (those that end 
in .html) listed in this tab. These pages contain additional links pointing to 
other pages. By adding their file extension to the left hand list, these files will 
be downloaded and scanned by RAGE Sitemap Automator. You would not want 
picture files or movie files here since they cannot be scanned for additional 
links.

Any file extensions not listed in the left hand list are still added to your 
sitemap. If you want to prevent files from being added to your sitemap, create 
filters that exclude certain files from being added to your sitemap file.

Removing Unneeded Variables in a URL Query
The ‘Scanning Files’ tab also allows you to remove certain variables from a 
URL’s query string before adding them to your sitemap file. A query string is 
everything that comes after the ? in your URL. For example, in the URL http://
www.mydomain.com?variable1=hello&variable2=goodbye the query string is ?
variable1=hello&variable2=goodbye.

If you have a database driven website such as a blog or a store catalogue, you 
will probably see these queries in your URLs. Often times, there may be extra 
variables in a query URL that lead to a page that has already been added to 
your sitemap file. In this case, you can tell RAGE Sitemap Automator to remove 
certain variables, and their value, before adding them to your sitemap file. If 
the URL is already in your sitemap file, it will not get added. This helps remove 
duplicate pages from being added to your sitemap file.

You may want to strip the following variables;
1) PHP session ids, which are used to keep track of a users settings on your 

website
2) Variables that specify the sorting order of a catalogue of items
3) Variables that will lead to the same page, with the same content, whether or 

not they are present in the URL

By default, RAGE Sitemap Automator contains a list of variables that are 
normally not needed.
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Search Engine Optimization Tips
There are many different techniques that people can do to help improve their 
search engine rankings. The following is 11 of the basic techniques that all 
websites should follow along with tips for implementing them in WebDesign 
(http://www.ragesw.com/webdesign.php) and RAGE Sitemap Automator;

1) Include a descriptive, keyword rich title 
Keep it to the point and include your most important keywords. Make sure it 
makes sense when someone reads it because this is the first thing they will see 
when your page comes up in search engine results. A good technique is to name 
your product/service/website then add a short description of what it does/is.

<TITLE>WebDesign: Download The Macintosh HTML Editor</TITLE>
• The above title names the product, tells the user what it is, what platform it 
is for and what this page will let them do. Remember, short but descriptive is 
the key. It is the first thing a user will notice in the search results page.

2) Include meta keywords and descriptions
WebDesign lets you easily do this from the 'New Web Page...' command from 
under the File menu. Just select the Meta data section. Add keywords or 2-3 
word phrases separated by commas. Use highly targeted keywords and use as 
few as possible while still getting the most important keywords across. Never 
try to add as many as you can think of.

Keep your description short and to the point. Some search engines don't use 
this meta data anymore in the results listing, however some still do including 
Google, and some still use it to see if your page is relevant. Include important 
keywords and make sure it makes sense to people when they read it.

3) Include the char-set and language meta data
WebDesign can do this for you as well in the 'New Web Page...' wizard from 
under the File menu. Although this does not necessarily help ranking, some 
search engines limit searches to certain languages and may use this data to 
determine your website's language. It never hurts to include it.

4) Provide as much text as possible
When you can, turn images into text. Take advantage of CSS to create buttons 
and logos that are all text and not images. Search engines cannot use images 
when they index your web page. WebDesign provides some great CSS features 
(the plug-ins at the bottom of the Tools window and the CSS Language 
Extensions under Window Menu->Language Extensions). You can find a complete 
reference in WebDesign as well from the built in Language Extensions.
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The more text you have the more content search engines can index. So start 
writing as much as you can. Use important keywords that you used in your title 
and your keywords/description meta tags that are discussed above. REMEMBER: 
make the text relevant to your visitors first, than to search engines.

5) Use all the places you can to insert extra content
 Always take advantage of the alt tag, which stands for alternative text for 
image tags. This text shows up in images that cannot be found as well as for 
people using web browsers that do not support images. Make sure your 
alternative text describes what the picture is in a very short 2-3-word 
description. Try to include important keywords if you can. WebDesign lets you 
specify alternative text in the Image Wizard (from under the Insert menu or 
from the Tools window).

Other places you may want to consider adding text is in the table summary tag. 
Click within your <TABLE> tags in WebDesign and use the attribute editor 
(Windows menu->Attribute Editor) to edit the summary tag for a table. Keep 
this short as well and use keywords if possible,

6) Pay attention to important content
Search engines use the text within header tags (<H#>...</H#>) extensively. Use 
them at the top of your page and try to put important keywords within them. 
Also, pay attention to the first paragraph and especially the first sentence on 
your web page. Try to put as many keywords as possible in them, while still 
making sense to visitors reading it. Lastly, link text in-between the <a> tag, 
known as anchor text, is also very important. Replace links that say 'Click Here' 
with keyword rich descriptions. Less important but still relevant is the text 
within bold tags.

7) Include an html site map of all your web pages
The site map that is being referred to here is an html site map, not an XML 
Sitemap. Do not exceed 100 links on your html site map and make sure your 
main page links to it so it is picked up by search engines. Your XML Sitemap, 
however, can contain as many links as you want.

8) Build your link popularity by posting your web page on forums (without 
spamming, but included in your signature)
Post on relevant blogs, swap links with similar web pages and write articles and 
submit them to e-zines with a link back to your web page. Unless you want to 
hurt your long-term ranking and reputation, never SPAM or annoy users with 
advertisements of your website on public forums or discussions.
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9) Always, always, always make your website readable to visitors before 
search engines. 
Do not use any illegal techniques, hidden keywords that are the same color as 
your background and try to avoid using frames.

10) Include an XML Sitemap with up to date and honest information about 
your website. 
XML Sitemaps help search engines when crawling your website by telling them 
which pages are important and which pages to visit. Use RAGE Sitemap 
Automator to automate the process of creating XML Sitemaps.

11) RULE OF THUMB: If your website is within the top 10 websites for your 
specific category, getting within the top ten listings should eventually 
follow. Be patient! 
It may take a few months for your website to rise in search engines, but keep 
building your links and online content and take advantage of the free web 
development forum at http://www.ragesw.com/forums/ to post your 
experiences and questions.
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